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A. Introduction 

The I-SMART database was developed by ACDI/VOCA through a TOPS program grant funded by USAID. I-

SMART was built to address different data management challenges resulting from the complexity and 

size of USAID Title II projects. It is designed to be a cost-effective information management system to 

support multisector program management and reporting that:  

 Builds on low-cost technology—Access 2010, a  software that is already included in the MS 

Office package 

 Allows for accurate reporting thanks to its user-friendly data collection forms and automated 

reports 

 Promotes partner ownership and capacity, in line with USAID/FORWARD1, and  

 Contributes to sustainability as it is an easily transferrable database that Title II2 implementers 

can share with their local and international partners, therefore building their data management 

and quality reporting capacity. 

This database’s features are drawn from the results of a survey ACDI/VOCA conducted in 2013 to assess 

the data quality and reporting needs of Title II project implementers. Most Title II projects are 

implemented in an integrated way across project components: For example, a household may be 

targeted by both the agriculture and food security activities. Therefore, I-SMART has been designed to 

be an integrated database to make it easier to assess the degree of integration across components. In 

addition, it uses identification numbers (ID) to identify each unique beneficiary and limit any risk of 

double-counting or over/underreporting. The data entry has been automated as much as possible 

through drop down lists and relationships among tables; entry of the same data in different tables has 

been limited (e.g., once you enter the details on one beneficiary, you won’t have to type in his or her 

details again when that beneficiary is benefitting from a different activity). The reports have also been 

automated so that they are updated as soon as the data have been entered.  

I-SMART is a foundational database. As such, it addresses some of the essential data management needs 

of most projects, but it is not meant to cover all projects’ specific needs. For those unaddressed needs, 

projects have the flexibility to add tables, forms and reports in I-SMART or use other tools.  

Though it is possible for all Title II projects to use this database at all stages of the project, please note 

that it is preferable to begin using it when the project is starting up and building its M&E system.  

                                                           
1 In 2010, USAID undertook an ambitious reform agenda called USAID/FORWARD, an effort to strengthen the 
agency by embracing new partnerships, investing in the catalytic role of innovation, and demanding a relentless 
focus on results. 
2 Title II of the Food for Peace Act provides in-kind commodities and associated costs. This program comprises the 
majority of USAID food assistance programming.  
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This manual is intended to help I-SMART users manage and populate the database. That includes 

everyone involved in entering and editing data, as well as analyzing data and reports. This will primarily 

be the M&E staff and the project management staff. The manual will help them: 

 Understand how the database works 

 Enter and edit data 

 Import data from other sources 

 View and read the reports, and 

 Export the data and the reports. 

It also includes a section on using Magpi3 as one of the possible ways to populate the database.  

It is very important to read the entire manual before populating the database. 

As mentioned above, the database is designed in Microsoft Access 2010. In order to get the most 

benefit from I-SMART, users should have some familiarity with Access.  

For use as a reference, the I-SMART 2.0 database can be located at http://www.acdivoca.org/resources.  

B. How to open the database 

To open the database, open the Access I-SMART 2.04 file. It leads directly to the Main Menu screen 

(figure 1) to facilitate data entry and access to reports and to limit access to the tables, forms and 

queries files. This is intended to limit the risk of unintentionally deleting or editing them and to show a 

less encumbered screen. However, if you need them, go to the Access File menu, then Options, Current 

Database and activate the Navigation Pane at the bottom of the page (figure 2).  

                                                           
3 In 2003, Dr. Selanikio and Dr. Donna pooled decades of experience in global health, disaster response, 
technology, and international development to develop new technology that would enable easier mobile data 
collection for NGOs and nonprofits, forming DataDyne (now Magpi). 
4 The I-SMART user manual was not revised with the update from I-SMART 1.0 to I-SMART 2.0, as no system 
changes were performed. 

http://www.acdivoca.org/resources
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Figure 1: The I-SMART Main Menu screen 

 

Figure 2: How to display the navigation pane 

C. How to enter data 

To enter data, click on the “Enter or edit data” button in the Main Menu screen. This will lead you to a 

page with the “Registration forms” and “Activities forms” buttons. Click on the relevant button to access 

the needed data collection forms. 
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1. Registration versus Activities forms 

The Registration forms are for registering the beneficiaries, the intervention areas, the different 

trainings, equipment, crops, livestock, etc., that the project works with.  

The Activities forms are for recording the project activities the beneficiaries are participating in. For 

example, an individual is registered in the Individual beneficiaries registration form. Then, the care he 

(or she) benefits from or the trainings he (or she) participates in are recorded in the Care provision 

activity form (under the Health and nutrition activities forms) and the Training activity form.  

You must enter the individual’s data in the registration form before you can enter that he or she 

benefits from a particular activity. 

   

Figure 3: Registration versus Activities forms 

2. Where to begin 

 You need to fill out the Registration forms before you can enter information in the Activities 

forms. 

 Begin with the Administration Division Registration form and enter the different administration 

division levels in which the project works. Administration division level 4 (AL4) is the highest and 

AL1 is the lowest. For example, AL4 could be a district, AL1 is a village. AL3 might be a cercle 

(e.g. in Burkina Faso), or a chiefdom (e.g. in Sierra Leone), AL2 might be a commune or a section, 

and AL1 might be a village or a community. After you set up the types of administration levels, 

go to the Intervention areas registration forms and enter the names of each AL in which the 

project operates. The AL types you entered will appear in the drop-down list to facilitate the 

entry of the AL names. For the ACDI/VOCA Title II project in Sierra Leone, for example, the AL4 

type is a district and the AL4 names are Bombali, Kailahun, Koinadugu and Tonkolili. This means 
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that the project works in the districts of Bombali, Kailahun, Koinadugu and Tonkolili. Food 

distribution zones and health center zones will be entered in the AL1 forms. 

 After this, you will register the entities (groups) you are working with. You will see in all the 

entities registration forms that the AL types and names you entered are in the drop-down lists 

when you fill in the locations of each entity. The entities registration forms will not let you 

choose or type in an AL type or name that you haven’t previously entered in the administrative 

division registration form and in the Intervention areas registration forms. 

 You can now fill out the Household registration form, after which you will record each individual 

beneficiary who is a member of each household and of each entity in the Individual beneficiaries 

form. In the latter, you will be able to enter all the groups each individual is member, either at 

the moment of the enrolment or later on, when s/he joins a new group. 

 The next step is to fill out the Project staff registration form. 

 Then, you can continue with the other registration forms.   

 Fill out as much as possible in all the registration forms before moving to the Activities forms.  

You will always be able to add ALs, beneficiaries, activities, staff, etc., as you register them in the 

course of the project. Just keep in mind the above-mentioned order: to add an individual 

beneficiary, you need to enter his or her household first and make sure that the ALs where he or she 

lives are in the AL lists. Otherwise, you will have to update the AL registration forms and enter the 

new locations. 

 

Figure 4: Drop-down list in the household registration form based on the data entered in the Intervention areas registration 
forms 
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Coding or ID setting 

You will notice that every beneficiary and activity in I-SMART must have an identification number (ID). 

IDs are necessary to prevent double counting and to ensure that beneficiaries receive the benefits to 

which they are entitled.  

This ID will ideally be set up by the Database Manager or M&E Manager and should be consistent 

project wide. Each individual or entity should have only one ID and each ID should correspond to only 

one individual or entity.  

Every type of beneficiary (group, household, individual) should have a different coding system so that 

one can recognize whether an ID is of a woman’s group or a producer group, of a household or an 

individual, etc.  

Every project may have its own coding principle in I-SMART provided it’s a numeric one and between -

2,147,483,648 and +2,147,483,647. One of the most efficient coding systems is based on a sequence of 

codes of locations where the beneficiary lives. For example, an individual beneficiary code will have nine 

digits. The first digit will represent the AL4 code, (assuming the project works in nine or fewer AL4; 

otherwise, you will use two digits). The next digit represents the AL3, the next one the AL2, then the 

next two digits represent the AL1 (assuming there are more than nine AL1s in one AL2). The next two 

digits represent the household number in that AL1 and the last two digits are the individual’s number in 

the household. This way, the AL4 code has one digit, AL3 has two digits, AL2 has three digits, AL1 has 

five, and a household has seven digits (see figure 5 below). 

 

Figure 5: Example of coding principle 

You may use the same principle for the entity beneficiaries but add a digit at the beginning to 

differentiate one entity type from another.  
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3. How to fill in each form 

In each form, you will see white areas (fields) where you should enter the relevant information 

(text/string, integer, decimal, date) corresponding to the text on the left side.  

 Identification numbers: All IDs are integer (numbers without any decimal from -2,147,483,648 to 

+2,147,483,647). 

 Names: all names are text strings that can be pure text or alphanumeric. 

 Decimals: only prices, costs and area data can use decimals, and most of them can have a 

maximum of four digits after the decimal separator.  

 Dates: Date formats are MM/DD/YYYY. Next to each date, when you have your cursor in the 

corresponding white area, you will have a date picker that you can use to enter the date.  

If you enter data that is in a different format than what the system expects, it will be refused and an 

error message will appear, letting you know to make the necessary change. For example, you cannot 

enter a number with a decimal when the field is set to an integer format, nor can you type an integer in 

a cell formatted for a date.  

Fields with drop-down lists cannot be filled in with anything other than what is in the list. To add items 

in the list, you need to edit the corresponding registration form. For example, to add a location of an 

individual beneficiary that is not in the ALs lists, you need to go to the Intervention areas registration 

forms and add the new location there. Once this is done, you will have the location automatically added 

in the related AL drop-down list in the Individual beneficiaries registration form.  

When you have the cursor in the field you want to fill in, the relevant instructions will appear at the 

bottom left of the page, as shown in figure 6 below.  
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Figure 6: Completion instructions 

When you reach the end of the form page, you will see blue buttons that will allow you to: 

 Add a new record 

 See the previous record 

 Save the data just entered, and 

 Exit the form 

Note that even if you do not click on the save button, normally your data is automatically saved; 

however, it is safer to click before you exit the form. 

You can also navigate through records using the Access arrows at the bottom left of the form page (see 

figure 7 below). 

 

Figure 7: Access navigation arrows 

4. Notes on some specific data 

In order to calculate indicators and produce reports, the project must represent all data on costs and 

prices using the same currency. The same principle applies to production and area measurement units. 

Therefore, before those types of data are entered, the project needs to decide which units it will use. If 

the data has been collected in different measurement units, it needs to be converted to one type before 

it is entered in the database. Similarly, the meaning of some key words should remain the same across 
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areas and time. For example, “quantity” of road built/rehabilitated needs to be defined from the 

beginning, whether it is the number of roads or the number of kilometers.  

If a group of people are sharing one good or service from the project, record each person under the 

relevant activity table. For example, if four members of a Farmer Field School are sharing a single plow, 

each of them has benefitted from the project. Therefore, each of them should be recorded in the Ag 

Input and equipment provision activity form. However, the plow will be entered in only one individual’s 

row, so it is not reported as four plows provided. Therefore, in the other three individuals’ rows, the 

quantity of equipment will be 0.  

Following the same principle, in I-SMART, all beneficiaries of food distribution should be counted as 

separate individuals. So, for example, when a pregnant woman gives birth, her child should be entered 

as a new beneficiary in the individual beneficiaries’ registration form/table as soon as he or she starts 

receiving food or service from the project. This is to avoid under reporting that may occur when a 

woman delivers at the beginning of the annual reporting period, and her child starts receiving food six 

months later.  

For the calculation of the number of hectares under improved technologies/practices, in the agriculture 

technologies and management practices table and form, one plot of land planted by one farmer during 

one fiscal year should only be recorded once. Two records of plots of land of the same farmer during the 

same fiscal year mean that those are two different plots and should be both counted in the hectares 

calculation. 

In many Title II projects, food distribution activities are the entry point to the other project components. 

However, this is not always the case. For example, a woman may enter the project as a farmer and be 

assigned the individual status “other” (vs. “pregnant woman,” “lactating woman” or “child”). If she later 

becomes pregnant, she is then entitled to receive food. At this point, you must change her individual 

registration status in the Individual registration form/table to “pregnant woman.” This is because this 

initial status is one of the registration parameters for the identification and counting of people eligible 

for food distribution. Because she is already tracked as a beneficiary of the project’s agriculture 

component, this change of status will not impact her counting as an Ag beneficiary.  

The ration ID in the Food ration registration form/table absolutely need to be Child, Pregnant woman, 

Lactating woman and Household. The calculation of the quantity of food commodity distributed is based 

on this assumption. The use of any other terminologies will make the formula fail.  

As you will note, to facilitate the reporting and tables creation/automation, some maximum numbers 

were set, based on needs of most projects. For example, the number of targeted crops has been set to a 

maximum of five; the number of commodities has been set to a maximum of six; the number of 

agricultural technologies and practices has been set to a maximum of six; etc. If the project has higher 

numbers than the maximum, you should add columns in the tables and revise accordingly the queries 

and report formulas/codes. One easier option would be to regroup the items to get numbers lower than 

those maximums.  
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It is very important that the requested data fields in all forms be filled in completely, as some of them 

are crucial in the calculation of indicators and the production of reports. This especially true for 

birthdates, dates of delivery, etc. When a pregnant woman is registered, you can enter the expected 

date of delivery and then enter the actual date once the child is born.  

5. Importing data from other sources 

To populate the database, in addition to entering data in the data collection forms, you can import 

tables from other sources and append them to the I-SMART tables. To do this, the table you import 

must have exactly the same structure as the Access table that will receive the data. This means both 

tables need to have the same field names and the same data types. Also, the file to import should have 

the same or less number of fields than the Access table. Otherwise Access will return an error message 

and the import may fail.  

To import the data, go to the Access External data menu (see figure 8 below), Import and link, and 

choose the format of the table you want to import. Access accepts Excel and Access files among others. 

A dialogue box will open asking for the source and destination of the data. Indicate the file location and 

name and then choose “Append a copy of the records to the table.” Then indicate the name of the 

destination Access table and click on OK. You will see a message indicating whether the import was 

successful or not. Sometimes, the import is done despite some errors; you will see the details of those 

errors in a table that Access will create automatically, and which is named after the destination table. 

Another very simple way to import the data is copy/paste: you will copy the data in the Excel sheet and 

paste them in the Access table.  

 

Figure 8: The Access External data menu 
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Figure 9: The Access Select the source and destination of the data dialog box 

 

D. How to edit previously entered data 

The data edit follows the same principles and instructions as the first entry of the data. To locate the 

records to edit, use the blue “View previous” button at the bottom of the form page, or the Access 

navigation arrows as shown in figure 7.  

You may also use the search box at the top of each form page as shown in figure 10 below.  

 

Figure 10: Search box to locate records 
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If you want to delete records, delete the corresponding raw in the concerned table: select the row, and 

right click on it and choose delete record.  

E. How to view reports and indicator values 

1. How to get the reports 

Click on the “View indicators values and reports” button in the I-SMART main menu page and follow the 

prompts to find the reports data you want.  

In all the reports except the Ag and Livestock production and sales reports, which have annual data, 

select the start and end dates of the reporting period for which you want to see data. Thus, you can get 

monthly, quarterly or annual data, life of project data or even daily values of your indicators. Once you 

set those dates, you can click on the “Submit” button next to the report you want to see, as shown 

below. You can enlarge or reduce the width of the columns as needed.  

 

Figure 11: How to get the report table 

All the report tables are pivot tables (dynamic crosstabs) except a few such as the Ag and Livelihoods 

production and sales. This is to take advantage of the dynamic and flexible features of the pivot tools. To 

see more or less details, you can click on the plus or minus signs next to each field.  

A food distribution list is available among the Commodity management reports. It will include the 

names, location and status of all eligible beneficiaries for a given month. This list, based on an 

automated calculated status (pregnant woman, lactating woman or child) of each beneficiary, will be 

printed out and is intended to help the commodity management team prepare and implement the food 

distribution. After the distributions, the actual beneficiaries’ information will be entered in the food 

distribution activities form.  

2. How to read the reports 

Pivot tables make it easy to read data in a summarized but disaggregated way. In figure 11, we have a 

total of six unique individuals who received food from the project between 10/1/2012 and 9/30/2013. In 
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the first left grey cell, we see that three of them are children. Of the three children, we see in the top 

left white cell that one is from Food Distribution Zone 1.  

Another example is figure 12 below showing the number of household beneficiaries between 10/1/2012 

and 9/30/2013 (FY13). We can see that a total of four unique households have benefited from the 

project. All of them were enrolled before FY13, so they are all “continuing” beneficiaries as per the 

duration disaggregation required by USAID for this indicator. There is no “new” beneficiary because no 

household was enrolled in FY13.  

 

Figure 12: How to read the reports 

It is important to read the reports and interpret the values very carefully. For example, in order to get 

the total number of unique individual beneficiaries of food distribution for FY13, we need to look at the 

food distribution report table in figure 11. It shows us the figure of six. The table below (figure 13) gives 

us the monthly number of food distribution beneficiaries during the same reporting period. It is needed 

to get the values per month, not the total corresponding to the whole reporting period. The total of nine 

here is just the sum of all the cells’ figures. One person can (and is meant to) receive food several 

months during the reporting period and is therefore counted in several of the below cells. If we take the 

total number of beneficiaries who received food during the reporting period from figure 13 rather than 

figure 11, we are double counting and thus over-reporting. 

 

Figure 13: How to read the reports (2) 
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As explained earlier, it is important to define key terms such as “quantity” at the beginning of the 

project. In the table below, we have the quantity of infrastructures rehabilitated by type. The Grand 

Total data highlighted in figure 14 has less meaning if the road quantities are in kilometers and the 

WASH quantities are in numbers of wells. In this case, the project may only consider the other cells’ 

data.  

 

Figure 14: How to read the reports (3) 

3. How to export the reports 

If you want to export the pivot table to Excel, put the cursor on any part of the table, click on the Access 

Pivot Table tools tab, then on Export to Excel (see figure 15). This will automatically open an Excel sheet 

with the exported pivot table. That will allow you to design graphs and do further calculations that may 

be easier in Excel. The other non-pivot-table-based reports (such as the Ag and livelihoods production 

and sales data) are simple tables that one can copy and paste in Excel or Word.   

 

Figure 15: How to export the reports 
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F. For further analysis 

As mentioned earlier, I-SMART is a foundational database. It may not meet all the data needs of all 

projects. If you want to add tables, you will be able to do so by clicking on the Access Create table, then 

Table.  

If you want to conduct further analysis of your data, you can export your data into Excel or Access. Open 

the table you want to export and then go to the Access External Data tab, Export. When you click on the 

export format you want, a dialogue box will open, allowing you to choose the table to export and the 

destination folder and file name (see figure 16). 

Also, if you want to add pivot tables in your database, see Annex I – How to create a Pivot table. 

 

Figure 16: How to export the data 

G. Using the Magpi system 

1. What is Magpi 

Magpi (www.magpi.com), previously called Episurveyor, is a mobile data collection platform developed 

by the Datadyne Group. The I-SMART TOPS grant included testing of the compatibility of the Magpi 

system to collect data and import them into I-SMART. Magpi is one of the many possible ways to enter 

data in I-SMART. It uses mobile devices (phones, tablets) to collect data.  

Magpi is very easy to use. To get data through it: 

http://www.magpi.com/
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 First, open an account online (personal or project account) by providing information such as 

name, address, etc. A free account allows you to build up to 25 forms with a maximum of 100 

questions each and to collect and store up to a monthly total of 500 records. 

 Build the data collection forms in the Magpi website. 

 Identify what devices the project will use (see section 3. Choosing the right devices). 

 Download the Magpi software on the mobile devices. 

 Download the forms on the devices. 

 Collect the data using the phones. 

 Upload the collected data on Magpi’s website. 

 Download the data to the user’s computer. 

In addition, Magpi offers some simple analysis of the data. 

Magpi has very concise and helpful guides on each of those steps (e.g., at 

https://datadyne.zendesk.com/forums/20621347-Getting-Started-with-Magpi). In this manual, we will 

only address its use and link with I-SMART.  

 

Figure 17: Magpi 

2. Building data collection forms in Magpi 

You don’t need any programming skills to build forms in Magpi. You can watch some of the videos on 

the Magpi site and YouTube to guide you on how to design the forms. Magpi has several instructional 

webinar series on YouTube (e.g., http://www.youtube.com/watch?v=q7jpmT1OLnE).  

Magpi allows you to design your forms in any language. To facilitate data collection, you can write the 

forms in local languages. We noticed that Google Chrome allows a smoother manipulation of Magpi 

during the forms design compared with Internet Explorer and Mozilla Firefox. 

https://datadyne.zendesk.com/forums/20621347-Getting-Started-with-Magpi
http://www.youtube.com/watch?v=q7jpmT1OLnE
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As previously mentioned, in order to make your data importable in I-SMART, your Magpi tables must 

have exactly the same structure as the I-SMART destination tables. To achieve this, you need to properly 

set the names and types of each field in each of the Magpi forms. Also, Magpi doesn’t allow any space 

between characters in the questions modalities an automatically replace them with an underscore. If 

you have such modality in Access, you will need to replace all underscores to spaces before you import 

your data in Access.  

Twenty five forms have been developed on Magpi to collect the I-SMART data. They can be shared with 

you upon request to Maria Bina Palmisano (Mpalmisano@acdivoca.org). To be able to use them to 

collect your own data, set up your own Magpi account. Then send to Maria Bina Palmisano the email 

address you used to open your account. You will receive an email notifying you the list of forms that 

have been shared with you. You will see them in your Magpi account after you log in. Open each form 

and you can use the “Save as” command to rename it. You will then be able to edit the renamed forms, 

adapt them to your project’s needs and collect your own data. 

 

Figure 18: Easy design of the forms in Magpi 

3. Choosing the right devices 

On the Magpi website, there is a list of compatible mobile devices and a link to download the software 

to your devices. In our experience, however, not all the listed devices work with Magpi. We therefore 

recommend that you test some of the devices you already have in hand before you buy devices for all 

your data collection staff/enumerators, and buy only the models that work. Beware of the counterfeit 

devices sold in some developing countries.  
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If you need to collect data in an area with limited or no internet connectivity to upload the data, you will 

need to buy SD cards for the phones to store the data until you have an internet connection. The 

internal memory of the devices is important to inform your purchase decision making. It is also very 

important to have devices with durable batteries so that they last long enough to collect data before 

charging them.   

Even if you plan to extensively train the data collection staff on how to use the devices and the Magpi 

software, it is always better to have devices that are, or similar to, what they are already used to in 

order to. This familiarity helps to limit errors in entering the data, especially at the beginning of the data 

collection process.  

We tested different types of phones, including i-Phones, tablets, Androids and more basic phones. 

Magpi worked well even with middle-range phones of $100-$150.  

As mentioned in the Magpi guides, to install the software, you need to have the devices connected to 

wifi or you can download the software to your computer and install it on your device via Bluetooth or a 

USB cable. You want to bear this information in mind when choosing the devices and planning for the 

software installation. With a good internet connection, it takes less than five minutes to install the 

software. With a bad one, you may never succeed. 

 

Figure 19: List of Magpi compatible devices 

4. Downloading the forms and uploading the data 

In order to download the forms and upload the data from the phones to the Magpi server, you will need 

a good internet connection. Therefore, before giving the phones to the data collection staff, you should 

plan to have all the forms downloaded. Once this is done, the forms are stored in the devices and data 

can be collected offline.   
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If the internet connection is weak, you will need to upload the data in several steps. Once you have 

uploaded the data to the Magpi site, it is no longer in the devices. You will be able to see the data on the 

Mapgi site, after you login, under Forms, Data as specified in the Magpi guides (see figure 20). 

 

 

Figure 20: Data uploaded on Magpi 

5. Downloading the data and importing them to I-SMART 

You may want to download them as soon as they are available on the website and do some backups. 

You can do this by selecting the records and clicking on Export as shown in the Magpi guides. Data can 

be exported in Access or Excel.  

Before importing the data, you should check it for consistency, accuracy and completeness. Once the 

data is cleaned and properly structured, you can follow the instructions provided in this manual to 

import it to I-SMART (section Importing data from other sources). 

6. Other advice 

Like in any data collection process, you will need to train the data collection staff and their supervisors. 

The training will include sessions to familiarize the data collectors and supervisors with the devices in 

addition to the data collection forms, so plan for training sessions that are  one or two days longer than 

the classic paper-based data collection training. The testing phase will also take longer because it will 

test not only the forms but also the devices, the connectivity, how people react to the mobile data 

collection etc. You want to factor all of this into the planning and budgeting of your data collection 

process.  
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Magpi, like any mobile data collection tool, helps improve the quality of the data collected. To get the 

full benefit of this advantage, one needs to properly use the validation rules, data types and logic 

functions in Magpi as shown in the Magpi videos cited above. However, this is not enough to ensure full 

quality data. You will still need to implement the usual good practices such as the careful identification 

and training of the data collection staff, close supervision of the collection, verification of the 

respondents’ answers, checking and cleaning of the data etc.  

 

H. Final recommendations 

I-SMART will help improve the user project’s data quality. For example, automated data entry and 

calculation of the indicators and the way data types are set allows the project to have more reliable 

reports. The use of IDs contributes to the accuracy of the indicator values, etc. However, for it to be 

effective, all people involved in the data collection, management and use must be thoroughly trained on 

the system and its requirements and abilities.  

I-SMART will contribute more to complex Title II projects that are the beginning of their implementation 

so that there is no change/switch to manage from any previous system as would be the case for any 

already running project.  

One limitation of this non-web-based Access database is that its management should be centralized to 

avoid having different versions of the same database with several people. The database should be 

managed by one person who will keep the official version. Access allows file sharing on the web so that 

multiple people can enter data in one single file, but the typically large size of Access files often limits 

this, especially where internet connection is a challenge. A simple option is file sharing through the 

project’s intranet. In any case, the project should choose the most workable solution depending on its 

constraints and possibilities.  

One can easily protect the database via a password by clicking on File, then Info, then Encrypt with 

password but the project is encouraged to choose the best protection solution in discussion with its IT 

Specialist.  

Finally, as part of any data quality strategy, it is important to regularly back up the database onsite and 

offsite. You should do this whenever a significant amount of data has been entered.   
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Annex I – How to create Pivot tables 

Pivot tables are dynamic crosstabs that you can use to consolidate your data and do some analysis. This 

annex includes information available at http://office.microsoft.com/en-001/access-help/create-

pivottable-or-pivotchart-views-in-a-desktop-database-HA101901543.aspx#_Toc273693831  

Step 1: Identify the table or query 

Use can create pivot table from tables or queries. Identify or create the table or query you want to 
create the pivot table from. Make sure that your table/query includes:  

 Fields that contain the data you want to summarize (for example, number of individuals 
registered); 

 Fields by which you want to compare data, such as sex, or first activity in the project etc. 

If you plan to count individuals/services in your PivotTable, you should also make sure your table has a 
unique ID field for the individuals/services you are counting. For example, to count the number of 
registered individuals, your table should include the ID of every individual. 

If the ID in your table is not yet unique, you must create a query to remove duplications.  

For guidance on how to create a query, see http://office.microsoft.com/en-001/access-
help/introduction-to-queries-HA010341786.aspx?CTT=5&origin=HA101901543  

Step 2: Open the table/query in PivotTable view 

1. If the table/query is not already open, in the Navigation Pane, double-click the table/query 
(figure 21); 

2. On the Home tab, in the Views group, click View, and then click PivotTable View. Access 
displays a blank PivotTable view without any fields or data (figure 22). 

 

Figure 21: Open the table from the Navigation Pane 

Navigation pane 

http://office.microsoft.com/en-001/access-help/create-pivottable-or-pivotchart-views-in-a-desktop-database-HA101901543.aspx#_Toc273693831
http://office.microsoft.com/en-001/access-help/create-pivottable-or-pivotchart-views-in-a-desktop-database-HA101901543.aspx#_Toc273693831
http://office.microsoft.com/en-001/access-help/introduction-to-queries-HA010341786.aspx?CTT=5&origin=HA101901543
http://office.microsoft.com/en-001/access-help/introduction-to-queries-HA010341786.aspx?CTT=5&origin=HA101901543
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Figure 22: How to open the pivot table view 

Step 3: Add data fields to the PivotTable view 

In this step, you add the fields that make up the row and column headings of the PivotTable view, as 
well as the detail and filter fields. To do this, the Field List must be visible. 

 If the Field List is not visible, on the Design tab, in the Show/Hide group, click Field List (figure 
23). 

  

Figure 23: How to show the field list 

Add row fields 

Row fields are the ones that make up the rows of the PivotTable.  
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To add a row field: 

 Drag the field from the Field List to the area marked Drop Row Fields Here in the PivotTable. For 
example, you select as row field the first activity in the project (field IndFirstActivity in figure 
23); 

Alternatively, you can add the filter field by using the following procedure: 

1. Select the field in the Field List. 
2. At the bottom of the Field List, select Row Area from the drop-down list, and then click Add to. 

Add column fields 

As the name implies, column fields are the ones that make up the columns of the PivotTable. For 
example, you can have as column field the individual sex (field Sex in figure 23). 

To add a column field: 

 Drag the field from the Field List to the area marked Drop Column Fields Here in the PivotTable.  

Alternatively, you can add the filter field by using the following procedure: 

1. Select the field in the Field List. 
2. At the bottom of the Field List, select Column Area from the drop-down list, and then click Add 

to. 

Add detail fields 

Detail fields are the ones that make up the detail cells of the PivotTable. For example, it is the ID of the 
registered individuals. If you select as row first activity in the project (IndFirstActivity) and as column the 
sex (Sex), you will have the registered individuals disaggregated by sex and by first activity in the project.  

To add a detail field: 

 Drag the field from the Field List to the area marked Drop Totals or Detail Fields Here in the 
PivotTable.  

Alternatively, you can add the filter field by using the following procedure: 

1. Select the field in the Field List. 
2. At the bottom of the Field List, select Detail Area from the drop-down list, and then click Add to. 

In the individual registration pivot table, you will see in the cells in the pivot table the ID of the 
individuals by sex and by first activity in the project (figure 24). If you want to get the count of individual 
ID rather than the ID themselves, right click on any of the ID cells, then, click on Autocalc and then Count 
(figure 25). Alternatively, you can also click on Autocalc in the Design tab, Tools group. You will see that 
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you can use different calculation methods in addition to the Count one (Sum, First, Last, Average etc.). 
Then, select any field title (e.g. Sex) and go to Hide Details in the PivotTable Tools menu.  

 

Figure 24: Adding fields to the pivot table 

 

Figure 25: Commands to change the detail field calculation values 
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Figure 26: Detail field with Count calculated values 

Add filter fields 

Filter fields are optional. Adding a filter field allows you to filter the entire PivotTable by a value. For 
example, you can use the enrolment fiscal year field as a filter. As a result, the entire PivotTable can be 
filtered for specific FY. 

To add a filter field: 

 Drag the field from the Field List to the area marked Drop Filter Fields Here in the PivotTable.  

Alternatively, you can add the filter field by using the following procedure: 

1. Select the field in the Field List. 
2. At the bottom of the Field List, select Filter Area from the drop-down list, and then click Add to. 

Move a field 

 Drag the field name to the location you want. Make sure to drag the field name itself (for 
example, IndFirstActivity), and not one of the field values. 

Delete a field 

 Select the field name that you want to delete, and then on the Design tab, in the Active Field 
group, click Remove Field. 
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 Note    This action removes the field from the view, but the field is still available in the 
underlying data source. 

Step 4: Add calculated detail fields and total fields to the view 

Add calculated detail fields 

1. On the Design tab, in the Tools group, click Formulas, and then click Create Calculated Detail 
Field. 
 
Access displays a Properties dialog box. 
 

2. In the Name box, type a name for the calculated field. 
3. In the larger box below the Name box, type the calculation that you want to perform. 

 

 Tip    While you are typing the calculation, you can use the drop-down list and the Insert Reference To 
button at the bottom of the Properties dialog box to add fields to the calculation. 

4. Click Change.  
 
Access adds the calculated field to the field list.  
 

5. Repeat steps 2 through 4 for any other calculated fields you want to create. 
6. Close the Properties dialog box. 
7. Add the calculated field to the PivotTable per the instructions in the section Add detail fields. 

Add total fields 

1. Make sure detail cells are displayed: select a column heading label, and then on the Design tab, 
in the Show/Hide group, click Show Details. 

2. Select one of the detail values for which you want to add a total. 
3. On the Design tab, in the Tools group, click AutoCalc, and then click the type of total you want 

to add. 
4. Repeat step 3 for any other types of totals you want to add. 

Step 5: Change field captions and format data 

1. In the PivotTable, select the label of the field that you want to change. 
2. On the Design tab, in the Tools group, click Properties. 
3. In the Properties dialog box, click the Captions tab. 
4. In the Caption box, type the caption you want, and then press ENTER. 
5. Set any other formatting options that you want for the captions. 
6. In the Properties dialog box, click the Format tab. 
7. Use the commands on the Format tab to sort data and to format the text and the cells. 
8. If your PivotTable contains total rows, click Hide Details on the Design tab to hide the detail 

fields and show only the total fields as mentioned previously. 
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9. Repeat steps 3 through 7 to set captions and formats for the total fields. 

 Tip    To show totals as a percentage of a grand total, select one of the totals, and then on the Design 
tab, in the Tools group, click Show As, and then select which grand total that you want to compare to 
(row total, column total, and so on.) 

Step 6: Filter, sort, and group data 

 To filter data, click the down-arrow next to any field name, and then select or the check boxes to 
obtain the filtering you want. 

 To group data: 

1. In the PivotTable, click the values that you want to group. For example, to group several cities 
together, click the first city, and then press and hold the CTRL key while you click the other cities 
you want to group. 

2. Right-click one of the selected values, and then click Group Items.  
 
Access creates a custom group level. You can change the caption and formatting of the group by 
using the procedure in the section Step 5: Change field captions and format data.  

After you have added a grouping level, you can select the group and then use the Expand Field and 
Collapse Field commands on the Design tab to view or hide the individual fields in the group, 
respectively.  

 

 

 


